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Abstract001

In-context learning (ICL) can significantly en-002
hance the complex reasoning capabilities of003
large language models (LLMs), with the key004
lying in the selection and ordering of demon-005
stration examples. Previous methods typically006
relied on simple features to measure the rele-007
vance between examples. We argue that these008
features are not sufficient to reflect the intrinsic009
connections between examples. In this study,010
we propose a curriculum ICL strategy guided011
by problem-solving logic. We select demon-012
stration examples by analyzing the problem-013
solving logic and order them based on curricu-014
lum learning. Specifically, we constructed a015
problem-solving logic instruction set based on016
the BREAK dataset and fine-tuned a language017
model to analyze the problem-solving logic of018
examples. Subsequently, we selected appropri-019
ate demonstration examples based on problem-020
solving logic and assessed their difficulty ac-021
cording to the number of problem-solving steps.022
In accordance with the principles of curricu-023
lum learning, we ordered the examples from024
easy to hard to serve as contextual prompts.025
Experimental results on multiple benchmarks026
indicate that our method outperforms previous027
ICL approaches in terms of performance and028
efficiency, effectively enhancing the complex029
reasoning capabilities of LLMs. Our project030
will be publicly available subsequently.031

1 Introduction032

Large language models (LLMs) (Ouyang et al.,033

2022; Ye et al., 2023; Bahrini et al., 2023) can034

rapidly acquire new capabilities through in-context035

learning (ICL) to solve many new tasks (Wies036

et al., 2024; Xu et al., 2024), and can be extended037

through chain of thought (CoT) (Wei et al., 2022)038

to solve many tasks that require complex reason-039

ing (Hao et al., 2023; Zhang et al., 2023). Re-040

searchers believe that through ICL, LLMs can im-041

plicitly learn the problem-solving patterns demon-042

strated in contextual examples and apply them to043

(a)

Curriculum ICL Prompt

What is the 
probability of rolling 

one six-sided …?

Example 1
If q is the square of a 

positive integer, 
which of the …?

Example 2
If Tim had lunch at 

$50 and he gave 20% 
tip, how much …?

Example 3
A trader sold an article 
at a profit of 20% for 
Rs.360.   What is …?

Query

Select

Project

Select

Project

Project

(b)

Decomposition

Problem-Solving Logic:  
Select→Project→Comparative→Project

Problem-Solving Logic

Select

Project

Project

Arithmetic

Select

Project

Project

Arithmetic

Figure 1: (a) The transformation from QDMR to
problem-solving logic. (b) An example of curriculum
ICL. Example selection depends on the similar problem-
solving logic, and example ordering depends on the
number of operations contained in the logic.

new tasks (Bhattamishra et al., 2023; Dai et al., 044

2023). This means that LLMs have the ability to 045

learn and apply problem-solving patterns on the 046

spot from given examples. 047

In recent years, supervised fine-tuning (SFT) 048

methods (Dong et al., 2023) and reinforcement 049

learning optimization reasoning methods (Du et al., 050

2023; Guo et al., 2025) have been able to signif- 051

icantly enhance the reasoning abilities of LLMs 052

through training. Despite this, due to the unique 053

characteristic of ICL that it can enhance problem- 054

solving capabilities without training, it still holds 055

value as significant as the methods mentioned 056

above, especially when facing the need to reduce 057

costs or quickly apply to new tasks. Relevant 058

work (Hsieh et al., 2023) has already shown that 059

LLMs possess a wealth of basic knowledge and 060

fundamental capabilities that can be effectively ac- 061
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tivated through a small number of examples. Par-062

ticularly, LIMO (Ye et al., 2025) fine-tuned a large063

language model with only a few hundred examples064

and achieved results that are close to or even on065

par with the current state-of-the-art reinforcement066

learning optimization inference. Therefore, we be-067

lieve that the ICL capabilities of current LLMs are068

still far from being fully realized. There is a need069

to design better prompts to effectively enhance the070

effectiveness of ICL.071

ICL learns demonstration examples in sequence072

and then solves problems, which closely resembles073

the process of humans learning knowledge step074

by step. We believe that organizing demonstra-075

tion examples in a way similar to human educa-076

tional curriculum construction is crucial. It helps077

LLMs learn the knowledge and patterns shown in078

the examples and solve given problems effectively.079

Therefore, strategies for curriculum learning (Ben-080

gio et al., 2009) can be adopted for the organiza-081

tion of demonstration examples. The key to ICL082

lies in example selection and ordering, which re-083

quires measuring the relevance between examples.084

Traditional simple statistical information, such as085

similarity (Robertson et al., 2009; Wu et al., 2023a;086

An et al., 2023) and perplexity (Gonen et al., 2023;087

Margatina et al., 2023a), is not sufficient to reflect088

the intrinsic connections between examples, espe-089

cially from the perspective of problem-solving.090

In this work, we innovatively propose an091

problem-solving logic guided curriculum ICL092

method, which constructs the optimal ICL prompt093

for the query based on problem-solving logic. The094

Question Decomposition Meaning Representation095

(QDMR) (Wolfson et al., 2020) decomposes com-096

plex problems into several sub-questions for solv-097

ing and formalizes these sub-questions with 13098

custom "operations", which we refer to as problem-099

solving logic. Figure 1-(a) shows an example of100

problem decomposition and transformation into101

problem-solving logic. Although it cannot directly102

solve the problem, the problem-solving logic de-103

scribes the steps required for solving and the or-104

der of these steps in formal language. Therefore,105

it can accurately measure the intrinsic connec-106

tions between examples and construct a sequence107

of demonstration examples that are conducive to108

problem-solving. Figure 1-(b) shows an example109

of curriculum ICL. We select examples with sim-110

ilar problem-solving logic, which can help LLMs111

learn how to solve similar problems. Subsequently,112

we measure the difficulty of these examples by113

the number of problem-solving steps. The greater 114

the number of steps, the more reasoning steps are 115

involved, meaning the problem is more difficult 116

to solve. Relying on the principles of curriculum 117

learning, we order these examples from easy to 118

hard to serve as the final in-context prompt. 119

Our main contributions are as follows: 120

(1) This paper proposes a problem-solving logic 121

guided curriculum ICL strategy to enhance the rea- 122

soning performance of LLMs. We innovatively 123

present problem-solving logic as the criterion for 124

selection and ordering demonstration examples, 125

which is expected to offer a novel perspective for 126

future work. 127

(2) We constructed a problem-solving logic in- 128

struction set based on the BREAK dataset. Based 129

on this, we fine-tuned a language model to automat- 130

ically analyze the problem-solving logic of input 131

questions. 132

(3) Extensive experiments are conducted on five 133

datasets, and results show that our method achieves 134

significant improvements in average performance 135

and efficiency across all datasets, surpassing pre- 136

vious ICL methods and effectively enhancing the 137

ability of LLMs in reasoning tasks. 138

2 Background 139

2.1 In-Context Learning 140

ICL is a capability that emerges as the training data 141

and scale of LLMs increase (Dong et al., 2022). 142

This allows LLMs to learn new tasks with only a 143

few examples. Examples generally contain ques- 144

tions and answers. The query needs to maintain 145

consistent formatting with the examples so that 146

LLMs can provide accurate responses. This pro- 147

cess is called few-shot. 148

Existing research shows that the key to enhanc- 149

ing ICL performance lies in the organization of 150

demonstration examples, that is, the selection and 151

ordering of examples. Taking text similarity as an 152

example, the general process is to encode the can- 153

didate examples and the query into vector forms, 154

and then select the examples most similar to the 155

query by calculating the similarity between vectors. 156

Subsequently, these examples are sorted according 157

to text similarity. Finally, the sorted examples are 158

then input into the LLMs together with the query 159

for solving. 160
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question: What color are a majority of the objects?

“objects”

#1 select

“colors of #1”

#2 project
“number of #1 
for each #2”

#3 group
“#2 where #3 is 

highest”

#4 superlative

sub-question 1 sub-question 2 sub-question 3 sub-question 4

Decomposition

Figure 2: A QDMR example. The original question is
decomposed into four sub-questions, each represented
by an operation.

2.2 Problem-Solving Logic161

QDMR is a general method for decomposing com-162

plex questions into several sub-questions for solv-163

ing. They manually designed 13 operations, with164

each sub-question represented by an operation. The165

researchers proposed the BREAK dataset through166

manual annotation, which contains 60K question-167

answer pairs. Specific examples of each operation,168

as well as detailed information about the dataset,169

can be found in the Appendix A.170

This work is inspired by QDMR and refers to the171

sequence of operators representing sub-questions172

as the problem-solving logic. The set of sub-173

questions decomposed by QDMR includes the re-174

quired steps and the order between steps. Figure 2175

shows a specific QDMR example. The original176

question is split into four sub-questions, each of177

which is described in a formal language with an178

operation, resulting in the corresponding problem-179

solving logic as follows:180

select→ project→ group→ superlative181

2.3 Curriculum Learning182

Curriculum learning is a machine learning strat-183

egy (Bengio et al., 2009). It suggests that the train-184

ing process should mimic human cognitive learning185

by starting with simple examples and gradually in-186

creasing in difficulty. The core of this method lies187

in how to measure the difficulty of examples, which188

often depends on the characteristics of the specific189

task. For example, in the field of computer vision,190

the number of objects in an image (Wei et al., 2016)191

or noise (Chen and Gupta, 2015) contained can be192

used to measure difficulty. In the field of natural193

language processing, sentence length (Platanios194

et al., 2019) can be used as a measure of difficulty.195

In addition to these, the difficulty can also be mea-196

sured by human educational level (Lee et al., 2023)197

or evaluation models (Soviany et al., 2020).198

3 Problem-Solving Logic Guided 199

Curriculum ICL 200

This paper introduces a problem-solving logic 201

guided curriculum ICL strategy. The overall 202

methodology is illustrated in Figure 3. Specifically, 203

we first constructed an instruction set based on the 204

BREAK dataset and fine-tuned a language model to 205

automatically analyze problem-solving logic. Then, 206

we analyzed the problem-solving logic for all data 207

in the benchmark training set to construct a dataset 208

of candidate examples. When an actual query is in- 209

put, its problem-solving logic is first analyzed and 210

then compared with the candidate examples, se- 211

lecting those with similar problem-solving steps as 212

demonstration examples. Furthermore, the number 213

of problem-solving steps serves as an appropriate 214

metric for assessing the difficulty of each example. 215

A greater number of steps means the problem is 216

more difficult to solve. This inspired us to apply 217

the principles of curriculum learning to order the 218

demonstration examples from easy to hard. Finally, 219

the ordered demonstration examples and the query 220

are combined to form the final prompt, which is 221

then input into the LLMs. The following sections 222

will offer a detailed explanation of how problem- 223

solving logic is analyzed, along with the process of 224

selecting and ordering demonstration examples. 225

3.1 Problem-Solving Logic Analysis 226

We first need to train a language model to analyze 227

the problem-solving logic, which is represented as 228

an ordered set of several problem-solving steps. 229

Our approach constructs an instruction set based 230

on the BREAK dataset. Specifically, the input to 231

the instruction set is a problem, and the output is 232

problem-solving logic and its formal language. The 233

formal language ensures that the model correctly 234

understands the problem-solving process. We then 235

fine-tune a Llama3-8B model (Touvron et al., 2023; 236

Dubey et al., 2024) with LoRA (Hu et al., 2022) on 237

this instruction set. Once the model is trained, it can 238

analyze problems from any dataset and extract their 239

problem-solving logic. Examples of the instruction 240

set can be found in the Appendix A. Details of fine- 241

tuning and hyperparameters can be found in the 242

Appendix B. 243

Analyzing the problem-solving logic is a crucial 244

step in our work, providing the foundation for the 245

subsequent curriculum ICL. 246
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Base LLM<Q, PSL>

SFT

LLM for 
PSL Generation

Step 1: 
PSL-LLM Construction

Step 2: 
Examples  Database Construction

Example 1

……

Example n

LLM for 
PSL Generation

Examples
<Q, PSL>

Step 3: 
Demo Examples Construction

Examples
<Q, PSL>PSL

Query

LLM for 
PSL Generation

Demo Example 1

Demo Example 2

Demo Example 3

Selection and Ordering

Step 4: 
Curriculum In-Context Learning

Query

Demo Examples Construction

Demo Example 1

Demo Example 2

Demo Example 3

Prompt Construction

LLM Answer

Figure 3: The overall flowchart of our method. First, a base LLM is fine-tuned using an instruction set for problem-
solving logic (PSL) constructed from the BREAK dataset. Then, suitable demonstration examples are selected
and ordered by analyzing the PSL of the candidate examples and the query. Finally, the selected demonstration
examples and the query form the full prompt, which is fed into the LLM to obtain the results.

Example 1: Select→Project→Project→Arithmetic 

Query logic: Select→Project→Project→Arithmetic

Example 2: Select→Project

Example 3: Select→Group→Project→Arithmetic 

Example 4: Project→Select→Project→Arithmetic 

Example 5: Select→Project→Project

√

√

√

×

×

Example Selection

Example Ordering

Example 2: Select→Project

Example 5: Select→Project→Project

Example 1: Select→Project→Project→Arithmetic 

2 steps

3 steps

4 steps

Difficulty 

Figure 4: The process of example selection and order-
ing. (✓) denotes similar problem-solving logic, (×)
indicates a matching failure, and red font indicates the
reason for the matching failure. Difficulty is measured
by the number of steps.

3.2 Curriculum ICL247

Based on the above problem analysis process, we248

can focus on problem-solving logic to guide the249

selection and ordering of demonstration examples.250

Figure 4 illustrates the process of example selection251

and ordering.252

3.2.1 Demonstration Example Selection253

First, we need to select appropriate demonstra-254

tion examples. Compared to semantic informa-255

tion, we believe that selecting examples with sim-256

ilar problem-solving logic is more important. On257

one hand, similar problem-solving logic can guide258

LLMs in reasoning, and on the other hand, exam-259

ples with similar logic but different semantics can260

enhance the model’s generalization ability.261

Algorithm 1 Demonstration Example Selection

Require: query T , LLM function F (·), set of can-
didate examples {E1, E2, . . . , En}, each ex-
ample Ei has its own solution logic Li =
{Oi1, Oi2, . . . , Oimi}.

Ensure: Mark matching demonstration examples.

1: LT ← F (T ) {Obtain the solution logic for the
query from LLM}

2: for each example Ei in {E1, E2, . . . , En} do
3: Li ← {Oi1, Oi2, . . . , Oimi} {Retrieve solu-

tion logic of Ei}
4: if Li is a subsequence of LT starting from

the first operator then
5: Mark Ei as a demonstration example
6: end if
7: end for

After analyzing the query and all candidate ex- 262

amples, our method selects demonstration exam- 263

ples based on the problem-solving logic. The se- 264

lection criterion requires that the problem-solving 265

operations set in each candidate example must be a 266

subsequence of the query, meaning both the types 267

of operations and their order must match exactly. 268

Suppose the query has a problem-solving logic 269

containing m operations, and the selected demon- 270

stration example has n operations (m ≥ n); the 271

n operations of the demonstration example must 272

match the first n operations of the query. This 273

method ensures that the demonstration example’s 274

problem-solving steps align with the first n steps 275

of the query, avoiding any mismatch or additional 276

problem-solving steps. The complete process is 277

detailed in Algorithm 1. 278
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Select→Project

Select→Project→Project 

Easy

Hard

Curriculum learning based on problem-solving logic

Guidance

question: What is the probability of rolling one six-sided dice, 
and  getting a different number on each die?
answer: For the first die, we can roll any one of six numbers ......

question: If q is the square of a positive integer, which of the 
following must be equal to the square of the next positive integer?
answer: q = (x)^2 where x is a positive integer ......

question: If Tim had lunch at $50 and he gave 20% tip, how 
much did he spend?
answer: The tip is 20% of what he paid for lunch ......

Selected examples

Query
In-context Prompt

Figure 5: A complete example of curriculum ICL. The selected examples form the context information. The right
half of the figure shows the problem-solving logic, which is the basis for example selection and ordering.

3.2.2 Demonstration Examples Ordering279

The key to curriculum learning lies in how to mea-280

sure the difficulty of examples. By introducing281

problem-solving logic, we can easily assess the dif-282

ficulty of each example. The problem-solving logic283

consists of several operations, where a higher num-284

ber of operations indicates more reasoning steps,285

thereby increasing the problem’s difficulty.286

Inspired by this, we applied curriculum learn-287

ing principles, ordering examples from easy to288

hard. Specifically, we sorted the examples in in-289

creasing order based on the number of problem-290

solving steps, and used them along with the query291

to construct the final in-context prompt. Figure 5292

shows a complete curriculum ICL example, includ-293

ing demonstration examples and the query.294

4 Experiments and Analysis295

4.1 Experimental Setup296

Benchmarks. Our experiment includes two types297

of datasets, Arithmetic Reasoning and Common-298

sense Reasoning, and validation is conducted on299

five different datasets. Arithmetic Reasoning: (1)300

the AQuA (Ling et al., 2017) includes 254 test ex-301

amples, (2) the SVAMP (Patel et al., 2021) includes302

1000 test examples, (3) the Gsm8k includes 1319303

test examples. Commonsense Reasoning: (1) the304

CommonsenseQA (Talmor et al., 2019) includes305

1211 test examples, (2) the StrategyQA (Geva et al.,306

2021) includes 229 test examples.307

Baselines. We compare our approach against308

seven methods that use ICL. Random selects309

demonstration examples and their order randomly.310

VoteK (Hongjin et al., 2022) selects the most sim-311

ilar k examples using k-nearest neighbors (KNN) 312

and sorts them according to similarity scores. 313

PromptSO (Shi et al., 2024) uses principal com- 314

ponent analysis (Abdi and Williams, 2010) to se- 315

lect the most relevant basis questions and sorts 316

them based on eigenvalue. AutoCoT (Zhang et al., 317

2022) uses k-means to automatically select the 318

most representative examples that are closest to 319

the cluster center. CoT+few-shot (Wei et al., 2022) 320

manually designed fixed demonstration examples 321

with reasoning processes. Self-Adaption ICL (SA- 322

ICL) (Wu et al., 2023b) selects similar examples 323

based on KNN and then chooses an appropriate 324

order based on information compression. Active 325

Learning ICL (AL-ICL) (Margatina et al., 2023b) 326

selects most similar examples based on the princi- 327

ples of active learning and sorts them according to 328

similarity. 329

Implement Details. We evaluate the effective- 330

ness of our method on the Llama3-8B model. For 331

each benchmark, we select demonstration exam- 332

ples from its training set to form prompt informa- 333

tion to evaluate each test set data. For the SVAMP 334

dataset, we adopted the same evaluation strategy 335

as in previous work (Patel et al., 2021), using 336

ASDiv-a (Miao et al., 2020) and MAWPS (Koncel- 337

Kedziorski et al., 2016) together as the training 338

set. To ensure a fair comparison, the number of 339

selected examples is based on the settings in CoT 340

(Wei et al., 2022) for different benchmarks, and our 341

experiments do not exceed that limit. 342

4.2 Main Results and Analysis 343

We compare the performance of our approach with 344

other ICL methods. All the comparison rusults are 345
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Method Selection
Stategy

Ordering
Stategy

Dataset Avg.SVAMP AQuA Gsm8k ComSenQA StrategyQA
Random Random Random 76.5% 46.5% 73.8% 75.8% 65.1% 67.53%
VoteK KNN Similarity 74.9% 44.9% 76.7% 75.4% 69.0% 68.19%

PromptSO PCA Eigenvalue 77.3% 43.7% 77.7% 75.6% 67.7% 68.40%
AutoCoT K-means Similarity 77.5% 47.2% 75.3% 76.0% 71.2% 69.44%

CoT + Fewshot Fixed Fixed 80.5% 44.5% 79.4% 75.1% 69.4% 69.79%
SA-ICL KNN Entropy 78.8% 47.6% 77.9% 78.5% 66.8% 69.95%
AL-ICL KNN Similarity 80.8% 45.7% 78.2% 77.9% 68.1% 70.13%

Ours PSL Curriculum 83.4% 50.8% 81.1% 75.0 71.6% 72.37%

Table 1: The table presents a comparison of experimental results across different benchmarks using Llama3-8B,
demonstrating the accuracy contrast between various ICL methods. Avg represents the average accuracy across the
different benchmarks. The best and second-best performances are highlighted in bold and underlined, respectively.

Difficulty
Strategy Ordering Dataset Avg.SVAMP AQuA Gsm8k ComSenQA StrategyQA

Original Llama
AL-ICL 80.8% 45.7% 78.2% 77.9% 68.1% 70.13%

Our Strategy
Prioritize simplicity w/ order 82.3% 47.6% 79.5% 75.5% 69.0% 70.79%

w/o order 82.5% 47.2% 78.8% 76.1% 68.1% 70.55%
Prioritize difficulty w/ order 81.8% 44.9% 77.9% 76.6% 67.7% 69.77%

w/o order 81.6% 46.1% 79.6% 77.0% 67.2% 70.29%
Select Randomly w/ order 81.3% 50.6% 80.2% 76.1% 70.3% 71.70%

w/o order 80.9% 48.6% 79.2% 76.0% 71.2% 71.17%
Prioritize diversity w/ order 83.4% 50.8% 81.1% 75.0% 71.6% 72.37%

w/o order 80.5% 46.1% 80.1% 76.0% 65.9% 70.11%

Table 2: The table presents the accuracy of benchmarks under different difficulty selection strategies. "w/ order"
indicates that the examples are ordered based on curriculum learning, while "w/o order" means the examples are
randomly ordered. The best and second-best performances are highlighted in bold and underlined, respectively.

tabulated in Table 1. Experimental results show346

that compared with other ICL methods, we achieve347

the best performance on SVAMP, AQuA, Gsm8k348

and StrategyQA. Overall, our method improves the349

average accuracy of all benchmarks by 2.24%. This350

result shows that our method effectively improves351

the model’s reasoning performance. To further352

demonstrate the effectiveness of the method, we353

conducted multiple sets of experiments for illustra-354

tion.355

4.2.1 Analysis of Example Selection and356

Ordering357

For the selection and ordering strategies of demon-358

stration examples in ICL, we designed several sets359

of experiments to verify the effectiveness of our360

method.361

Regarding example selection, since each query362

may match far more examples than the specified363

limit during the problem-solving logic analysis,364

it is necessary to analyze specific difficulty sam-365

pling strategies. We designed four difficulty sam-366

pling strategies: (1) Prioritize simplicity: This367

strategy selects easy examples first. (2) Prioritize368

difficulty: This strategy selects difficult examples369

first. (3) Select randomly: This strategy randomly370

selects examples of any difficulty. (4) Prioritize 371

diversity: This strategy aims to select as many 372

difficulty levels as possible, sampling at most one 373

example from each difficulty level. 374

Regarding the ordering of examples, to validate 375

the effectiveness of curriculum learning, we de- 376

signed two sets of controlled experiments. Under 377

the four sampling strategies mentioned above, we 378

applied two ordering strategy: (1) difficulty in- 379

creasing ordering (w/ order) and (2) random 380

ordering (w/o order). 381

The complete experimental results are shown in 382

Table 2, and through analysis, we have made the 383

following observations: 384

First, it can be noted from the table that the 385

performance of the strategies using the problem- 386

solving logic and curriculum learning approach 387

generally outperforms AL-ICL. The prioritize di- 388

versity (w/ order) strategy significantly outper- 389

forms the others, achieving an average accuracy 390

of 72.37%. 391

Furthermore, the importance of curriculum learn- 392

ing is highlighted in our findings. For prioritize 393

diversity strategies, the effect of ordering is par- 394

ticularly pronounced. In contrast, the impact of 395
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Figure 6: (a) shows the relationship between the average standard deviation of different example selection
strategies and their performance across various benchmarks. (b) shows the impact of example ordering strategies on
performance in relation to the average standard deviation under different selection strategies.

Strategy Dataset Avg. TimeSVAMP AQuA Gsm8k ComSenQA StrategyQA
Fixed Examples 8 4 8 7 6 6.60 109%

Prioritize simplicity 7.27 4 7.73 7 5.88 6.38 117%
Prioritize difficulty 7.27 4 7.15 5.82 5.84 6.02 167%
Select Randomly 7.49 4 7.73 7 5.88 6.42 144%

Prioritize diversity 2.16 3.19 3.38 3.19 1.8 2.74 100%

Table 3: The number of demonstration examples selected by different selection strategies in benchmarks. Avg
represents the average number of demonstration examples selected for each data. Time indicates the time cost
comparison across different strategies. The highlighted part represent the strategy with most efficient.

ordering is less significant for the prioritize sim-396

plicity and prioritize difficulty strategies.397

Based on the findings above and considering the398

characteristics of different selection strategies, we399

believe that the primary reason for these results is400

data diversity, or more specifically, difficulty diver-401

sity. To explain this phenomenon, we calculated402

the difficulty levels included in the demonstration403

examples for each data across all benchmarks and404

computed the average standard deviation. Standard405

deviation (std) is typically used to measure the de-406

gree of variation, and this metric helps illustrate407

the data diversity produced by different strategies.408

We analyzed two sets of data: first, the rela-409

tionship between difficulty diversity and strategy410

performance; and second, the impact of difficulty411

diversity on the four strategies, considering both412

the cases with and without ordering.413

Figure 6-(a) depicts the relationship between per-414

formance and difficulty diversity across the four415

selection strategies. There is a clear positive corre-416

lation between difficulty diversity and performance,417

suggesting that data diversity is key to improving418

performance. Additionally, Figure 6-(b) shows the419

relationship between the performance difference420

(with and without ordering) and difficulty diver- 421

sity across the four selection strategies. We found 422

that ordering strategies are highly sensitive to dif- 423

ficulty diversity. Overall, the higher the difficulty 424

diversity, the greater the improvement brought by 425

ordering. Notably, the prioritize diversity strat- 426

egy saw the largest performance improvement with 427

ordering. This highlights the effectiveness of cur- 428

riculum learning, where it is essential to order data 429

according to difficulty. At the same time, it sup- 430

ports the idea that measuring example difficulty 431

by the number of problem-solving steps is a valid 432

approach. 433

4.2.2 Analysis of the Number of Examples 434

The number of demonstration examples for each 435

query also has an important impact on the perfor- 436

mance of ICL, as well as on the reasoning effi- 437

ciency of LLMs. Table 3 presents the number of 438

demonstration examples included with each test 439

data across different strategies. For comparison, 440

we use the fixed number of examples in CoT (Wei 441

et al., 2022) as a reference. 442

We find that the prioritize diversity strategy has 443

significantly superior performance while also hav- 444
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ing the least average number of demonstration445

examples. The average number of demonstra-446

tion examples for other strategies is more than447

6, while priority diversity strategy only requires448

2.74. Fewer examples indicate a shorter in-context449

length, which helps the reasoning speed of LLMs.450

Table 3 also presents the average time cost under451

different strategies. We uses the priority diversity452

strategy as the baseline at 100% to measure the453

time cost of other strategies. Experimental results454

show that, compared to other strategies, the prior-455

itize diversity strategy has a time cost advantage,456

reducing consumption by 9% to 67%, effectively457

improving inference performance.458

Current studies have shown that an increase in459

the number of demonstration examples usually460

leads to improved performance (Bertsch et al.,461

2024). Our method demonstrates that the quan-462

tity of examples is not the only influencing factor.463

This conclusion is consistent with numerous stud-464

ies (Levy et al., 2023; Xie et al., 2024; Peng et al.,465

2024), which indicate that data diversity plays a466

critical role in enhancing the generalization capa-467

bility of LLMs.468

5 Related Work469

5.1 In-Context Learning470

GPT-3 (Brown et al., 2020) exhibited few-shot471

and zero-shot learning abilities during the pretrain-472

ing phase. CoT (Wei et al., 2022) designed sev-473

eral fixed demonstration examples manually as in-474

context information, inspired further research on475

ICL (Yao et al., 2024).476

Subsequent research has shown that the key477

to ICL lies in demonstration examples selection478

and ordering (Nguyen and Wong, 2023; Li and479

Qiu, 2023; Guo et al., 2024). Regarding ex-480

ample selection, AutoCoT (Zhang et al., 2022)481

used k-means clustering to select representative482

examples and leveraged zero-shot CoT to gener-483

ate their reasoning process as demonstration exam-484

ples. PromptSO (Shi et al., 2024) used principal485

component analysis (Abdi and Williams, 2010) to486

encode text and calculate similarity to select exam-487

ples. Another work (Rubin et al., 2022) points out488

that a retriever can be trained using annotated data489

to determine whether an example is suitable for a490

query. Regarding example ordering, a study (Lu491

et al., 2022) randomly generated multiple combi-492

nations of example orderings to create probe sets.493

By analyzing the entropy of predicted labels for494

each probe set, the researchers selected the best- 495

performing order. KATE (Liu et al., 2022) explored 496

ordering examples based on task relevance as well 497

as length-based sorting. Relevance-based ordering 498

prioritizes examples closely related to the target 499

task, while length-based sorting considers potential 500

advantages for specific tasks. 501

5.2 Curriculum Learning in LLMs 502

Numerous applications across various fields have 503

demonstrated that curriculum learning can effec- 504

tively enhance model training outcome (Hacohen 505

and Weinshall, 2019; Wang et al., 2021). 506

Currently, some works have applied curricu- 507

lum learning to LLMs (Kim and Lee, 2024; Wang 508

et al., 2024). A common approach is to train the 509

model with examples progressing from easy to 510

hard during fine-tuning. For instance, a study (Lee 511

et al., 2023) conducted fine-tuning on a structured 512

dataset that strictly covers multiple educational 513

stages to simulate the progressive learning char- 514

acteristics of humans. In the medical field, simi- 515

larly, human-defined and automatically generated 516

methods were used to annotate data difficulty, and 517

LLMs in the medical question-answering domain 518

were fine-tuned from easy to hard. (Lee et al., 2023). 519

Additionally, another work (Pouransari et al., 2024) 520

decomposed datasets into sequences of varying 521

lengths, using sequence length as a metric to mea- 522

sure data difficulty. 523

Another common approach for applying cur- 524

riculum learning to LLMs is ICL. For example, 525

ICCL (Liu et al., 2024) utilized human experts or 526

LLM-driven metrics to assess data difficulty, and 527

gradually increased the difficulty of demonstration 528

examples from easy to hard. 529

6 Conclusion 530

This paper proposes a problem-solving logic 531

guided ICL strategy. By analyzing the problem- 532

solving logic, we measure the similarity between 533

problems and select demonstration examples. Ad- 534

ditionally, the difficulty of problems is assessed 535

based on the number of problem-solving steps, and 536

the selected examples are ordered from easy to 537

hard following the principles of curriculum learn- 538

ing. Experimental results across multiple bench- 539

marks demonstrate that our proposed method out- 540

performs other ICL methods in terms of average 541

performance, significantly improving the reasoning 542

capabilities of LLMs. 543
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Limitations544

Although our work improves the performance and545

efficiency of LLMs in reasoning tasks, there are546

still limitations for improvement. First, due to hard-547

ware resource constraints, we only conducted ex-548

periments on LLMs at the 8B scale, and further549

validation of our method is necessary on larger550

models, such as those at the 70B scale, to fully551

demonstrate its effectiveness. On the other hand,552

we observed in many-shot studies (Bertsch et al.,553

2024) that a significant increase in the number of554

examples leads to substantial improvements in rea-555

soning performance. However, due to the limita-556

tions of benchmarks and hardware resources, we557

were unable to evaluate the effect of curriculum558

learning when applied to a large number of exam-559

ples. We believe that when both the quantity and560

quality of examples are ensured, reasoning perfor-561

mance can be further improved, which will be a562

focus of our future work.563

Potential Risks564

Our work does not carry any obvious risks.565

Acknowledgements566

References567

Hervé Abdi and Lynne J Williams. 2010. Principal568
component analysis. Wiley interdisciplinary reviews:569
computational statistics, 2(4):433–459.570

Shengnan An, Zeqi Lin, Qiang Fu, Bei Chen, Nan-571
ning Zheng, Jian-Guang Lou, and Dongmei Zhang.572
2023. How do in-context examples affect compo-573
sitional generalization? In Proceedings of the 61st574
Annual Meeting of the Association for Computational575
Linguistics (Volume 1: Long Papers), pages 11027–576
11052.577

Aram Bahrini, Mohammadsadra Khamoshifar, Hos-578
sein Abbasimehr, Robert J Riggs, Maryam Esmaeili,579
Rastin Mastali Majdabadkohne, and Morteza Pase-580
hvar. 2023. Chatgpt: Applications, opportunities,581
and threats. In 2023 Systems and Information Engi-582
neering Design Symposium (SIEDS), pages 274–279.583
IEEE.584

Yoshua Bengio, Jérôme Louradour, Ronan Collobert,585
and Jason Weston. 2009. Curriculum learning. In586
Proceedings of the 26th annual international confer-587
ence on machine learning, pages 41–48.588

Amanda Bertsch, Maor Ivgi, Uri Alon, Jonathan Berant,589
Matthew R Gormley, and Graham Neubig. 2024. In-590
context learning with long-context models: An in-591
depth exploration. arXiv preprint arXiv:2405.00200.592

Satwik Bhattamishra, Arkil Patel, Phil Blunsom, and 593
Varun Kanade. 2023. Understanding in-context learn- 594
ing in transformers and llms by learning to learn dis- 595
crete functions. arXiv preprint arXiv:2310.03016. 596

Tom Brown, Benjamin Mann, Nick Ryder, Melanie 597
Subbiah, Jared D Kaplan, Prafulla Dhariwal, Arvind 598
Neelakantan, Pranav Shyam, Girish Sastry, Amanda 599
Askell, Sandhini Agarwal, Ariel Herbert-Voss, 600
Gretchen Krueger, Tom Henighan, Rewon Child, 601
Aditya Ramesh, Daniel Ziegler, Jeffrey Wu, Clemens 602
Winter, Chris Hesse, Mark Chen, Eric Sigler, Ma- 603
teusz Litwin, Scott Gray, Benjamin Chess, Jack 604
Clark, Christopher Berner, Sam McCandlish, Alec 605
Radford, Ilya Sutskever, and Dario Amodei. 2020. 606
Language models are few-shot learners. In Ad- 607
vances in Neural Information Processing Systems, 608
volume 33, pages 1877–1901. Curran Associates, 609
Inc. 610

Xinlei Chen and Abhinav Gupta. 2015. Webly super- 611
vised learning of convolutional networks. In Pro- 612
ceedings of the IEEE international conference on 613
computer vision, pages 1431–1439. 614

Damai Dai, Yutao Sun, Li Dong, Yaru Hao, Shuming 615
Ma, Zhifang Sui, and Furu Wei. 2023. Why can gpt 616
learn in-context? language models secretly perform 617
gradient descent as meta-optimizers. In Findings of 618
the Association for Computational Linguistics: ACL 619
2023, pages 4005–4019. 620

Guanting Dong, Hongyi Yuan, Keming Lu, Cheng- 621
peng Li, Mingfeng Xue, Dayiheng Liu, Wei Wang, 622
Zheng Yuan, Chang Zhou, and Jingren Zhou. 2023. 623
How abilities in large language models are affected 624
by supervised fine-tuning data composition. arXiv 625
preprint arXiv:2310.05492. 626

Qingxiu Dong, Lei Li, Damai Dai, Ce Zheng, Zhiy- 627
ong Wu, Baobao Chang, Xu Sun, Jingjing Xu, and 628
Zhifang Sui. 2022. A survey on in-context learning. 629
arXiv preprint arXiv:2301.00234. 630

Yuqing Du, Olivia Watkins, Zihan Wang, Cédric Co- 631
las, Trevor Darrell, Pieter Abbeel, Abhishek Gupta, 632
and Jacob Andreas. 2023. Guiding pretraining in 633
reinforcement learning with large language models. 634
In International Conference on Machine Learning, 635
pages 8657–8677. PMLR. 636

Abhimanyu Dubey, Abhinav Jauhri, Abhinav Pandey, 637
Abhishek Kadian, Ahmad Al-Dahle, Aiesha Letman, 638
Akhil Mathur, Alan Schelten, Amy Yang, Angela 639
Fan, et al. 2024. The llama 3 herd of models. arXiv 640
preprint arXiv:2407.21783. 641

Mor Geva, Daniel Khashabi, Elad Segal, Tushar Khot, 642
Dan Roth, and Jonathan Berant. 2021. Did aristotle 643
use a laptop? a question answering benchmark with 644
implicit reasoning strategies. Transactions of the 645
Association for Computational Linguistics, 9:346– 646
361. 647

Hila Gonen, Srini Iyer, Terra Blevins, Noah A Smith, 648
and Luke Zettlemoyer. 2023. Demystifying prompts 649

9

https://proceedings.neurips.cc/paper_files/paper/2020/file/1457c0d6bfcb4967418bfb8ac142f64a-Paper.pdf


in language models via perplexity estimation. In650
Findings of the Association for Computational Lin-651
guistics: EMNLP 2023, pages 10136–10148.652

Daya Guo, Dejian Yang, Haowei Zhang, Junxiao Song,653
Ruoyu Zhang, Runxin Xu, Qihao Zhu, Shirong Ma,654
Peiyi Wang, Xiao Bi, et al. 2025. Deepseek-r1: In-655
centivizing reasoning capability in llms via reinforce-656
ment learning. arXiv preprint arXiv:2501.12948.657

Qi Guo, Leiyu Wang, Yidong Wang, Wei Ye, and Shikun658
Zhang. 2024. What makes a good order of examples659
in in-context learning. In Findings of the Associa-660
tion for Computational Linguistics ACL 2024, pages661
14892–14904.662

Guy Hacohen and Daphna Weinshall. 2019. On the663
power of curriculum learning in training deep net-664
works. In International conference on machine learn-665
ing, pages 2535–2544. PMLR.666

Shibo Hao, Yi Gu, Haodi Ma, Joshua Hong, Zhen667
Wang, Daisy Wang, and Zhiting Hu. 2023. Rea-668
soning with language model is planning with world669
model. In Proceedings of the 2023 Conference on670
Empirical Methods in Natural Language Processing,671
pages 8154–8173.672

SU Hongjin, Jungo Kasai, Chen Henry Wu, Weijia Shi,673
Tianlu Wang, Jiayi Xin, Rui Zhang, Mari Ostendorf,674
Luke Zettlemoyer, Noah A Smith, et al. 2022. Selec-675
tive annotation makes language models better few-676
shot learners. In The Eleventh International Confer-677
ence on Learning Representations.678

Cheng-Yu Hsieh, Chun-Liang Li, Chih-kuan Yeh,679
Hootan Nakhost, Yasuhisa Fujii, Alex Ratner, Ranjay680
Krishna, Chen-Yu Lee, and Tomas Pfister. 2023. Dis-681
tilling step-by-step! outperforming larger language682
models with less training data and smaller model683
sizes. In Findings of the Association for Computa-684
tional Linguistics: ACL 2023, pages 8003–8017.685

Edward J Hu, Yelong Shen, Phillip Wallis, Zeyuan686
Allen-Zhu, Yuanzhi Li, Shean Wang, Lu Wang, and687
Weizhu Chen. 2022. LoRA: Low-rank adaptation of688
large language models. In International Conference689
on Learning Representations.690

Jisu Kim and Juhwan Lee. 2024. Strategic data or-691
dering: Enhancing large language model perfor-692
mance through curriculum learning. arXiv preprint693
arXiv:2405.07490.694

Rik Koncel-Kedziorski, Subhro Roy, Aida Amini, Nate695
Kushman, and Hannaneh Hajishirzi. 2016. Mawps:696
A math word problem repository. In Proceedings of697
the 2016 conference of the north american chapter of698
the association for computational linguistics: human699
language technologies, pages 1152–1157.700

Bruce W Lee, Hyunsoo Cho, and Kang Min Yoo. 2023.701
Instruction tuning with human curriculum. arXiv702
preprint arXiv:2310.09518.703

Itay Levy, Ben Bogin, and Jonathan Berant. 2023. Di- 704
verse demonstrations improve in-context composi- 705
tional generalization. In Proceedings of the 61st An- 706
nual Meeting of the Association for Computational 707
Linguistics (Volume 1: Long Papers), pages 1401– 708
1422. 709

Xiaonan Li and Xipeng Qiu. 2023. Finding support 710
examples for in-context learning. In Findings of the 711
Association for Computational Linguistics: EMNLP 712
2023, pages 6219–6235. 713

Wang Ling, Dani Yogatama, Chris Dyer, and Phil Blun- 714
som. 2017. Program induction by rationale genera- 715
tion: Learning to solve and explain algebraic word 716
problems. In Proceedings of the 55th Annual Meet- 717
ing of the Association for Computational Linguistics 718
(Volume 1: Long Papers), pages 158–167. 719

Jiachang Liu, Dinghan Shen, Yizhe Zhang, William B 720
Dolan, Lawrence Carin, and Weizhu Chen. 2022. 721
What makes good in-context examples for gpt-3? 722
In Proceedings of Deep Learning Inside Out (Dee- 723
LIO 2022): The 3rd Workshop on Knowledge Extrac- 724
tion and Integration for Deep Learning Architectures, 725
pages 100–114. 726

Yinpeng Liu, Jiawei Liu, Xiang Shi, Qikai Cheng, and 727
Wei Lu. 2024. Let’s learn step by step: Enhancing 728
in-context learning ability with curriculum learning. 729
arXiv preprint arXiv:2402.10738. 730

Yao Lu, Max Bartolo, Alastair Moore, Sebastian Riedel, 731
and Pontus Stenetorp. 2022. Fantastically ordered 732
prompts and where to find them: Overcoming few- 733
shot prompt order sensitivity. In Proceedings of the 734
60th Annual Meeting of the Association for Compu- 735
tational Linguistics (Volume 1: Long Papers), pages 736
8086–8098. 737

Katerina Margatina, Timo Schick, Nikolaos Aletras, and 738
Jane Dwivedi-Yu. 2023a. Active learning principles 739
for in-context learning with large language models. 740
In Findings of the Association for Computational 741
Linguistics: EMNLP 2023, pages 5011–5034. 742

Katerina Margatina, Timo Schick, Nikolaos Aletras, and 743
Jane Dwivedi-Yu. 2023b. Active learning principles 744
for in-context learning with large language models. 745
In Findings of the Association for Computational 746
Linguistics: EMNLP 2023, pages 5011–5034. 747

Shen-yun Miao, Chao-Chun Liang, and Keh-Yih Su. 748
2020. A diverse corpus for evaluating and developing 749
english math word problem solvers. In Proceedings 750
of the 58th Annual Meeting of the Association for 751
Computational Linguistics, pages 975–984. 752

Tai Nguyen and Eric Wong. 2023. In-context ex- 753
ample selection with influences. arXiv preprint 754
arXiv:2302.11042. 755

Long Ouyang, Jeffrey Wu, Xu Jiang, Diogo Almeida, 756
Carroll Wainwright, Pamela Mishkin, Chong Zhang, 757
Sandhini Agarwal, Katarina Slama, Alex Ray, et al. 758

10

https://openreview.net/forum?id=nZeVKeeFYf9
https://openreview.net/forum?id=nZeVKeeFYf9
https://openreview.net/forum?id=nZeVKeeFYf9


2022. Training language models to follow instruc-759
tions with human feedback. Advances in neural in-760
formation processing systems, 35:27730–27744.761

Arkil Patel, Satwik Bhattamishra, and Navin Goyal.762
2021. Are nlp models really able to solve simple763
math word problems? In Proceedings of the 2021764
Conference of the North American Chapter of the765
Association for Computational Linguistics: Human766
Language Technologies, pages 2080–2094.767

Keqin Peng, Liang Ding, Yancheng Yuan, Xuebo768
Liu, Min Zhang, Yuanxin Ouyang, and Dacheng769
Tao. 2024. Revisiting demonstration selection770
strategies in in-context learning. arXiv preprint771
arXiv:2401.12087.772

Emmanouil Antonios Platanios, Otilia Stretcu, Graham773
Neubig, Barnabás Poczós, and Tom Mitchell. 2019.774
Competence-based curriculum learning for neural775
machine translation. In Proceedings of the 2019776
Conference of the North American Chapter of the777
Association for Computational Linguistics: Human778
Language Technologies, Volume 1 (Long and Short779
Papers), pages 1162–1172.780

Hadi Pouransari, Chun-Liang Li, Jen-Hao Rick Chang,781
Pavan Kumar Anasosalu Vasu, Cem Koc, Vaishaal782
Shankar, and Oncel Tuzel. 2024. Dataset decom-783
position: Faster llm training with variable sequence784
length curriculum. arXiv preprint arXiv:2405.13226.785

Stephen Robertson, Hugo Zaragoza, et al. 2009. The786
probabilistic relevance framework: Bm25 and be-787
yond. Foundations and Trends® in Information Re-788
trieval, 3(4):333–389.789

Ohad Rubin, Jonathan Herzig, and Jonathan Berant.790
2022. Learning to retrieve prompts for in-context791
learning. In Proceedings of the 2022 Conference792
of the North American Chapter of the Association793
for Computational Linguistics: Human Language794
Technologies, pages 2655–2671.795

Fobo Shi, Peijun Qing, Dong Yang, Nan Wang, Youbo796
Lei, Haonan Lu, Xiaodong Lin, and Duantengchuan797
Li. 2024. Prompt space optimizing few-shot rea-798
soning success with large language models. In Find-799
ings of the Association for Computational Linguistics:800
NAACL 2024, pages 1836–1862.801

Petru Soviany, Claudiu Ardei, Radu Tudor Ionescu, and802
Marius Leordeanu. 2020. Image difficulty curricu-803
lum for generative adversarial networks (cugan). In804
Proceedings of the IEEE/CVF winter conference on805
applications of computer vision, pages 3463–3472.806

Alon Talmor, Jonathan Herzig, Nicholas Lourie, and807
Jonathan Berant. 2019. Commonsenseqa: A question808
answering challenge targeting commonsense knowl-809
edge. In Proceedings of the 2019 Conference of810
the North American Chapter of the Association for811
Computational Linguistics: Human Language Tech-812
nologies, Volume 1 (Long and Short Papers), pages813
4149–4158.814

Hugo Touvron, Louis Martin, Kevin Stone, Peter Al- 815
bert, Amjad Almahairi, Yasmine Babaei, Nikolay 816
Bashlykov, Soumya Batra, Prajjwal Bhargava, Shruti 817
Bhosale, et al. 2023. Llama 2: Open founda- 818
tion and fine-tuned chat models. arXiv preprint 819
arXiv:2307.09288. 820

Xin Wang, Yudong Chen, and Wenwu Zhu. 2021. 821
A survey on curriculum learning. IEEE transac- 822
tions on pattern analysis and machine intelligence, 823
44(9):4555–4576. 824

Xin Wang, Yuwei Zhou, Hong Chen, and Wenwu Zhu. 825
2024. Curriculum learning: Theories, approaches, 826
applications, tools, and future directions in the era of 827
large language models. In Companion Proceedings 828
of the ACM on Web Conference 2024, pages 1306– 829
1310. 830

Jason Wei, Xuezhi Wang, Dale Schuurmans, Maarten 831
Bosma, Fei Xia, Ed Chi, Quoc V Le, Denny Zhou, 832
et al. 2022. Chain-of-thought prompting elicits rea- 833
soning in large language models. Advances in neural 834
information processing systems, 35:24824–24837. 835

Yunchao Wei, Xiaodan Liang, Yunpeng Chen, Xiaohui 836
Shen, Ming-Ming Cheng, Jiashi Feng, Yao Zhao, and 837
Shuicheng Yan. 2016. Stc: A simple to complex 838
framework for weakly-supervised semantic segmen- 839
tation. IEEE transactions on pattern analysis and 840
machine intelligence, 39(11):2314–2320. 841

Noam Wies, Yoav Levine, and Amnon Shashua. 2024. 842
The learnability of in-context learning. Advances in 843
Neural Information Processing Systems, 36. 844

Tomer Wolfson, Mor Geva, Ankit Gupta, Matt Gard- 845
ner, Yoav Goldberg, Daniel Deutch, and Jonathan 846
Berant. 2020. Break it down: A question understand- 847
ing benchmark. Transactions of the Association for 848
Computational Linguistics, 8:183–198. 849

Zhiyong Wu, Yaoxiang Wang, Jiacheng Ye, and Ling- 850
peng Kong. 2023a. Self-adaptive in-context learn- 851
ing: An information compression perspective for in- 852
context example selection and ordering. In Proceed- 853
ings of the 61st Annual Meeting of the Association for 854
Computational Linguistics (Volume 1: Long Papers), 855
pages 1423–1436. 856

Zhiyong Wu, Yaoxiang Wang, Jiacheng Ye, and Ling- 857
peng Kong. 2023b. Self-adaptive in-context learn- 858
ing: An information compression perspective for in- 859
context example selection and ordering. In Proceed- 860
ings of the 61st Annual Meeting of the Association for 861
Computational Linguistics (Volume 1: Long Papers), 862
pages 1423–1436. 863

Shan Xie, Man Luo, Chadly Daniel Stern, Mengnan 864
Du, and Lu Cheng. 2024. Demoshapley: Valua- 865
tion of demonstrations for in-context learning. arXiv 866
preprint arXiv:2410.07523. 867

Xin Xu, Yue Liu, Panupong Pasupat, Mehran Kazemi, 868
et al. 2024. In-context learning with retrieved demon- 869
strations for language models: A survey. arXiv 870
preprint arXiv:2401.11624. 871

11



Shunyu Yao, Dian Yu, Jeffrey Zhao, Izhak Shafran,872
Tom Griffiths, Yuan Cao, and Karthik Narasimhan.873
2024. Tree of thoughts: Deliberate problem solving874
with large language models. Advances in Neural875
Information Processing Systems, 36.876

Junjie Ye, Xuanting Chen, Nuo Xu, Can Zu, Zekai Shao,877
Shichun Liu, Yuhan Cui, Zeyang Zhou, Chao Gong,878
Yang Shen, et al. 2023. A comprehensive capability879
analysis of gpt-3 and gpt-3.5 series models. arXiv880
preprint arXiv:2303.10420.881

Yixin Ye, Zhen Huang, Yang Xiao, Ethan Chern, Shijie882
Xia, and Pengfei Liu. 2025. Limo: Less is more for883
reasoning. arXiv preprint arXiv:2502.03387.884

Yifan Zhang, Jingqin Yang, Yang Yuan, and An-885
drew Chi-Chih Yao. 2023. Cumulative reason-886
ing with large language models. arXiv preprint887
arXiv:2308.04371.888

Zhuosheng Zhang, Aston Zhang, Mu Li, and Alex889
Smola. 2022. Automatic chain of thought prompt-890
ing in large language models. arXiv preprint891
arXiv:2210.03493.892

Yaowei Zheng, Richong Zhang, Junhao Zhang, YeYan-893
han YeYanhan, and Zheyan Luo. 2024. LlamaFac-894
tory: Unified efficient fine-tuning of 100+ language895
models. In Proceedings of the 62nd Annual Meet-896
ing of the Association for Computational Linguistics897
(Volume 3: System Demonstrations), pages 400–410,898
Bangkok, Thailand. Association for Computational899
Linguistics.900

A BREAK Dataset Description901

BREAK is a dataset proposed by the Allen Insti-902

tute (Wolfson et al., 2020). This work introduces903

the Question Decomposition Meaning Represen-904

tation (QDMR), which breaks down a question905

into several sub-questions for solving and repre-906

sents it as a sequence of steps. The dataset collects907

60,150 question and QDMR pairs from several pub-908

lic datasets. To represent various questions as a uni-909

fied sequence of steps, they customized 13 types of910

operations, converting the solution process for all911

questions into sequences of these operations. The912

specific operations and their templates are shown913

in Table 4. The decomposition and formalization914

of questions can be found in Figure 1 and Figure 2.915

Table 5 shows the distribution of operations in the916

BREAK dataset, that is, the proportion of each op-917

eration appearing in a single data point. Table 6918

shows the distribution of the total number of sub-919

questions after decomposition in the dataset.920

Based on the BREAK dataset, we constructed921

an instruction set to analyze the problem-solving922

logic. Specific examples and explanations of the923

instruction set are provided in Table 7.924

B Fine-Tuning Details 925

We performed LoRA fine-tuning on the Llama3- 926

8B model using the aforementioned instruction set. 927

The specific hyperparameters are as follows: the 928

cutoff_len is set to 1024, the learning rate is set 929

to 5×10−5, the fine-tuning parameters are specified 930

as all, lora_rank is set to 8, lora_alpha is set 931

to 16, the optimizer used is AdamW, the model is 932

trained for 4 epochs, and the best model is selected 933

based on the BLEU score. 934

C Prompt Template 935

Table 8 shows the prompt templates used for fine- 936

tuning problem-solving logic analysis. 937

Table 9–13 shows the full prompt example for in- 938

context learning on the different benchmarks. 939

D Supplementary Details 940

Our experiments utilized the llama-factory (Zheng 941

et al., 2024) project, which includes model fine- 942

tuning and in-context learning. The CPU used in 943

the experiments is an Intel(R) Xeon(R) Platinum 944

8358 CPU @ 2.60GHz, and the GPU is an NVIDIA 945

Tesla A800 80G. The hyperparameters were set ac- 946

cording to the default configuration file provided by 947

llama-factory. The prompt length was set to 4096, 948

and the maximum answer output length was set to 949

1024. To ensure output stability, the temperature 950

was set to 0.01. In our study, we used ChatGPT to 951

assist in coding. 952
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Operator Template / Signature Question Decomposition
Select Return [entities]

w → Se

How many touchdowns were scored overall? 1. Return touchdowns
2. Return the number of #1

Filter Return [ref] [condition]
So,w → So

I would like a flight from Toronto to San Diego
please.

1. Return flights
2. Return #1 from Toronto
3. Return #2 to San Diego

Project Return [relation] of [ref]
w,Se → So

Who is the head coach of the Los Angeles
Lakers?

1. Return the Los Angeles Lakers
2. Return the head coach of #1

Aggregate Return [aggregate] of [ref]
wagg,So → n

How many states border Colorado? 1. Return Colorado
2. Return border states of #1
3. Return the number of #2

Group Return [aggregate] [ref1] for each [ref2]
wagg,So,Se → Sn

How many female students are there in each
club?

1. Return clubs
2. Return female students of #1
3. Return the number of #2 for each #1

Superlative Return [ref1] where [ref2] is [highest /
lowest]
Se,Sn,wsup → Se

What is the keyword, which has been con-
tained by the most number of papers?

1. Return papers
2. Return keywords of #1
3. Return the number of #1 for each #2
4. Return #2 where #3 is highest

Comparative Return [ref1] where [ref2] [comparison]
[number]
Se,Sn,wcom,n → Se

Who are the authors who have more than 500
papers?

1. Return authors
2. Return papers of #1
3. Return the number of #2 for each of #1
4. Return #1 where #3 is more than 500

Union Return [ref1] , [ref2]
So,So → So

Tell me who the president and vice-president
are?

1. Return the president
2. Return the vice-president
3. Return #1 , #2

Intersection Return [relation] in both [ref1] and [ref2]
w,Se,Se → So

Show the parties that have representatives in
both New York state and representatives in
Pennsylvania state.

1. Return representatives
2. Return #1 in New York state
3. Return #1 in Pennsylvania state
4. Return parties in both #2 and #3

Discard Return [ref1] besides [ref2]
So,So → So

Find the professors who are not playing Canoe-
ing.

1. Return professors
2. Return #1 playing Canoeing
3. Return #1 besides #2

Sort Return [ref1] sorted by [ref2]
Se,Sn → ⟨e1...ek⟩

Find all information about student addresses,
and sort by monthly rental.

1. Return students
2. Return addresses of #1
3. Return monthly rental of #2
4. Return #2 sorted by #3

Boolean Return [if / is] [ref1] [condition] [ref2]
So,w,So → b

Were Scott Derrickson and Ed Wood of the
same nationality?

...
3. Return the nationality of #1
4. Return the nationality of #2
5. Return if #3 is the same as #4

Arithmetic Return the [arithmetic] of [ref1] and
[ref2]
wari,n,n → n

How many more red objects are there than blue
objects?

...
3. Return the number of #1
4. Return the number of #2
5. Return the difference of #3 and #4

Table 4: The 13 operator types of QDMR steps. Listed are, the natural language template used to express the
operator, the operator signature and an example question that uses the query operator in its decomposition.

Operator QDMR
SELECT 100%
PROJECT 69.0%
FILTER 53.2%

AGGREGATE 38.1%
BOOLEAN 30.0%

COMPARATIVE 17.0%
GROUP 9.7%

SUPERLATIVE 6.3%
UNION 5.5%

ARITHMETIC 5.4%
DISCARD 3.2%

INTERSECTION 2.7%
SORT 0.9%
Total 60,150

Table 5: Operator prevalence in BREAK, that is, the
proportion of each operator appearing in a single data
point.

Steps QDMR
1-2 10.7%
3-4 44.9%
5-6 27.0%
7-8 10.1%
9+ 7.4%

Table 6: The distribution of the total number of QDMR
sub-questions.
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Input
\\The input is a problem to be solved, such as:
what flights are available tomorrow from denver to philadelphia?
Label
\\ The label contains <operator> and <formal language>.

\\ <operator> is an ordered set composed of the aforementioned custom operations.
\\ <formal language> is the formalized language that provides a detailed description
of each operator.
<operators>: [’select’, ’filter’, ’filter’, ’filter’]
<formal language>: ["SELECT[’flights’]", "FILTER[’#1’, ’from denver’]", "FIL-
TER[’#2’, ’to philadelphia’]", "FILTER[’#3’, ’if available’]"]

Table 7: Examples and Explanation of Instruction Sets Based on the BREAK Dataset

Prompt
You are a helpful assistant. Please break down in order the operations <operations>
required to solve the following problems, and the process of solving the problem
according to the operations <programs>:
what flights are available tomorrow from denver to philadelphia?
Label
<operators>: [’select’, ’filter’, ’filter’, ’filter’]
<formal language>: ["SELECT[’flights’]", "FILTER[’#1’, ’from denver’]", "FIL-
TER[’#2’, ’to philadelphia’]", "FILTER[’#3’, ’if available’]"]

Table 8: Fine-tuning prompts for problem-solving logic analysis
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Prompt
System prompt
Please provide the answer in the following format: "The final answer is <answer>"
User input
question: Being his favorite, he saved checking on the grapevines for his last stop. He was told by
235 of the pickers that they fill 100 drums of raspberries per day and 221 drums of grapes per day.
How many drums of grapes would be filled in 77 days?
answer: Equation is ( 221.0 * 77.0 ). The final answer is 17017.0

question: Tiffany was collecting cans for recycling. On Monday she had 4 bags of cans. The next
day she found some more bags worth of cans. If she had a total of 6 bags altogether, how many
bags did she find on the next day?
answer: Equation is ( 6.0 - 4.0 ). The final answer is 2.0

question: After a typhoon, 13 trees in Haley’s backyard died. If she had grown 3 trees initially, how
many more trees died in the typhoon than those that survived?
answer: Equation is ( 13.0 - ( 3.0 - 13.0 ) ). The final answer is 23.0

question: Brenda’s mother made cookies for 5 people. She prepared 22 cookies but had to throw
away 17 cookies. If each of them had the same number of cookies, how many did each of them
have?
answer: Equation is ( ( 22.0 - 17.0 ) / 5.0 ). The final answer is 1.0

question: Haley grew 9 trees in her backyard. After a typhoon 4 died. Then she grew 5 more trees.
How many trees does she have left?
Number of problem-solving logic step:
4->5->6->7->7

Table 9: Full prompt example for in-context learning on the SVAMP dataset
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Prompt
System prompt
Please provide the answer in the following format: "The final answer is <answer>"
User input
question: What is the probability of rolling one six-sided dice, and getting a different number on
each die? A)1/12 B)1/3 C)1 D)5/9 E)7/18
answer: Let’s think step by step. MAGOOSHOFFICIAL SOLUTION. For the first die, we can
roll any one of six numbers. For the second die, we can roll any number save for the number we
rolled on the first die, giving us 5 possibilities. For the third die, we can roll four different numbers
(we can’t roll the number we rolled on the first or second die). 6 possibilities out of 216 total
possibilities. 6/6 = 1. The final answer is C.

question: If q is the square of a positive integer, which of the following must be equal to the square
of the next positive integer? A)

√
n+ 1 B)n+ 1 C)n2 + 1 D)q + 2

√
q + 1 E)n2 + 2n+ 1

answer: Let’s think step by step. If q is the square of a positive integer, then q = (x)2 where x is a
positive integer. To calculate, (x+ 1)2 = x2 + 2x+ 1, which is q + 2

√
q + 1. This should be D.

The final answer is D.

question: If Tim had lunch at $50 and he gave 20% tip, how much did he spend? A)$60.00 B)$35.42
C)$60.60 D)$21.56 E)$78.45
answer: Let’s think step by step. The tip is 20% of what he paid for lunch. Tip = 20% of 50.00 =
$10.00. Total spent = 50.00 + 10.00 = $60.00. The final answer is A.

question: Carl is facing very difficult financial times and can only pay the interest on a $10,000 loan
he has taken. The bank charges him a quarterly compound rate of 4%. What is the approximate
interest he pays annually? A)$1600 B)$2000 C)$2150 D)$2500 E)$12000
answer: Let’s think step by step. The bank charges a 4% quarterly compounded annual rate. Per
quarter rate is (16/4)% = 4%. Thus, the quarterly compounded interest will be slightly more than
$1600. The final answer is A.

question: A shopkeeper employed a servant at a monthly salary of 1500. In addition to it, he agreed
to pay him a commission of 15% on the monthly sale. How much sale in Rupees should the servant
do if he wants his monthly income as 6000? A)30000 B)415000 C)31500 D)50000 E)None of
these
Number of problem-solving logic step:
2->3->4->5->6

Table 10: Full prompt example for in-context learning on the AQuA dataset
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Prompt
System prompt
Please provide the answer in the following format: "The final answer is <answer>"
User input
question: A shopkeeper bought 150 packets of milk. Each packet contained 250 ml of milk. If one
fluid ounce is equal to 30 ml, how many ounces of milk did he buy?
nanswer: Let’s think step by step. If the shopkeeper bought 150 packets of milk, each packet
containing 250ml of milk, all the packets had a total of 250*150 =«150*250=37500»37500ml.Since
one ounce equal 30 ml, the total amount of milk that the shopkeeper bought in oz is
37500/30=«37500/30=1250»1250 oz of milk. The final answer is 1250

question: Twenty gallons of tea were poured into 80 containers. Geraldo drank 3.5 containers. How
many pints of tea did Geraldo drink?
answer: Let’s think step by step. 20 gallons = 160 pints. 160/80 = «160/80=2»2 pints.3.5 * 2 pints
= «3.5*2=7»7 pints. Geraldo drank 7 pints of tea. The final answer is 7

question: During the holidays, Lance works as a merchandiser. He works 35 hours a week, spread
equally over 5 workdays. If Lance earns $9 an hour, how much does he make on each workday?
answer: Let’s think step by step. Lance works 35 / 5 = «35/5=7»7 hours a day. So he makes $9 x 7
= $«9*7=63»63 on each workday. The final answer is 63

question: A snack machine accepts only quarters. Candy bars cost ¢25, each piece of chocolate
costs ¢75, and a pack of juice costs ¢50. How many quarters are needed to buy three candy bars,
two pieces of chocolate, and one pack of juice?

answer: Let’s think step by step. Three candy bars cost ¢25 x 3 = ¢«25*3=75»75. Two pieces
of chocolate cost ¢75 x 2 = ¢«75*2=150»150. So, the total amount needed to buy those is ¢75
+ ¢150 + ¢50 = ¢«75+150+50=275»275. Since a quarter is equal to ¢25, therefore ¢275/¢25 =
«275/25=11»11 quarters are needed. The final answer is 11

question: Mark makes custom dog beds. A bed for a Rottweiler takes 8 pounds of stuffing, a bed
for a chihuahua takes 2 pounds of stuffing, and a bed for a collie takes the average amount of
stuffing between the first two kinds of beds. How many pounds of stuffing does Mark need to make
4 chihuahua beds and 3 collie beds?
Number of problem-solving logic step:
5->6->7->8->8

Table 11: Full prompt example for in-context learning on the Gsm8k dataset
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Prompt
System prompt
Please provide the answer in the following format: "The final answer is <answer>"
User input
question: What is the only was to recover from exhaustion? A. mediate B. have rest C. stay in bed
D. run out of steam E. go to sleep
answer: B

question: Google Maps and other highway and street GPS services have replaced what? A. united
states B. mexico C. countryside D. atlas E. oceans
answer: D

question: You can share files with someone if you have a connection to a what? A. freeway B. radio
C. wires D. computer network E. electrical circuit
answer: D

question: If a person isn’t able to pay their bills what must they do? A. know everything B.
acknowledgment C. make more money D. throw a party E. spare time
Number of problem-solving logic step:
1->2->3->3

Table 12: Full prompt example for in-context learning on the ComSenQA dataset

Prompt
System prompt
Please provide the answer in the following format: "The final answer is yes or no"
User input
question: Can you buy Casio products at Petco?
answer: Casio is a manufacturer of consumer electronics and watches. Petco is a chain store that
sells pet supplies like food, bowls, litter, toys, cages and grooming equipment. The final answer is
no

question: Did Clark Gable appear in any movies scored by John Williams?
answer: Clark Gable died in 1960. John Williams scored his first movie in 1961. The final answer
is no

question: Could a dandelion suffer from hepatitis?
answer: Only creatures that contain a liver can suffer from hepatitis. The liver is an organ only
found in vertebrates. Vertebrates exist in the kingdom Animalia. Dandelions are plants in the
kingdom Plantae. The final answer is no

question: Did Mozart ever buy anything from Dolce & Gabbana?
Number of problem-solving logic step:
2->3->4->4

Table 13: Full prompt example for in-context learning on the StrategyQA dataset
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